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Introduction 
Thank you for purchasing this digital HD Action Camcorder. Everything you need to take quality 

digital videos and photos is included with your camcorder. 

 

Vivitar makes capturing those special moments as easy as possible.  

 

Please read this manual carefully first in order to get the most out of your digital camcorder. 
 
NOTE: 

• Your digital action camcorder supports a Micro SD Memory Card (up to 32GB, Class 6 or 

higher).  

In order to use your digital action camcorder normally, please insert the Micro SD Memory 

card before use. 

Micro SD Memory cards are not included and need to be purchased separately. 

 

• This camera is a plug and play device. You can download the pictures and videos without 

the software by directly accessing the memory card from your computer. We would 

however recommend that you install the ‘Vivitar Experience Image Manager’ Software to 

enjoy the full Vivitar experience. 
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What’s Included 

 

 

 
1. Action Camcorder 5. Bicycle Mount 
2. USB Cable 6. Helmet Mount & Band 
3. Wireless Remote Control  7. AC Adapter 
4. Waterproof Casing 8. Built-in Lithium Battery (not shown) 

 

NOTE:  

• Micro SD Card not included. 
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Parts of the Camcorder  

 
 

 

 

1.  Shutter / OK button 9. Down / Zoom Out Button 

2.  Microphone 10. Menu / Back Button 

3.  Power / Mode Button  11. Lens 

4.  Tripod Mount 12. LCD Screen 

5.  Reset Button 13. LED Busy Light Indicator 

6.  Micro SD Memory Card Slot 14. LED Charge Light Indicator 

7.  Micro USB Interface  15. Infrared Signal Reception Light 

8.  UP / Zoom In Button  

 

 

 

 



 5 

Initial Camcorder Setup 

CHARGING THE BATTERY 

To charge the battery, follow either one of the charging methods below: 

CHARGING VIA THE COMPUTER 
1. Power off the camera. 

2. Use the supplied USB cable to connect the smaller end of the USB cable into the USB 

slot on the camcorder. Connect the other end to the USB interface of your computer.  

See images below: 1 and 2. 

3. The LED charge light turns on while charging is in progress. The charge light turns off 

when the battery is fully charged.  See images below: 3 and 4. 
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CHARGING VIA THE AC ADAPTER 
1. Power off the camera. 

2. Use the supplied USB cable to connect the smaller end of the USB cable into the USB 

slot on the camcorder. Connect the other end to the cable to the AC Adapter and then 

plug the AC Adapter into a power socket. See images below: 1 and 2. 

3. The charge light will turn off when the battery is fully charged.  

See images below: 3 and 4. 
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BATTERY INDICATOR 
The following icons appear on the camera and indicate the status of the camera’s battery power 

level: 

 

Battery Indicator Description 

 
The battery level is full. 

 
The battery level is half. 

 

The battery level is low, indicating to prepare for 

recharging the built-in lithium battery.  

Once ‘Low Battery’ appears on the LCD, this indicates 

that the battery level is completely exhausted, and the 

camcorder automatically turns off after a few seconds. 

Please fully recharge the battery. 
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INSTALLING THE MICRO SD MEMORY CARD 

Make sure a Micro SD Memory card Class 6 or higher (up to 32 GB) has been properly inserted 

into your camcorder.  Micro SD Memory card not included. 

To properly insert the Micro SD Memory Card:  

1. Power off the camcorder. 

2. Insert the Micro SD Card into the Micro SD Card slot in the direction as shown on the 

camcorder (see SD icon by the Micro SD card slot). 

3. Gently press the Micro SD Card until you hear a slight clicking sound. This indicates the 

memory card has been inserted correctly. 

4. To remove the card, gently press on the edge of the card to release it and pull the card 

out. 

5. If the card is inserted or removed while the camcorder's power is on, it may damage the 

card and/or any recorded data. Always confirm that the power is off before inserting the 

card into the camcorder. 

NOTE: Make sure there is room on the Micro SD Memory Card to capture images. If the 

memory card is full, additional images cannot be captured and saved to the card. 
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TURNING ON AND USING THE CAMERA 

 

Press the POWER button, located on top of the camcorder, to turn on the camcorder. 

 

 
 

RESET: If the camcorder becomes unresponsive, insert a thin pin into the RESET 

hole and gently push the pin until you hear a slight ‘click’ sound. The camcorder will 

then reset. 

 

 

 

NOTE: This camera includes a built-in lithium battery. To charge the battery, 

connect the camera using the USB cable to the computer’s USB port or to an AC 

charger. The charge light will turn off when the battery is fully charged. 

/ Switching Modes 



 10 

Remote Control 

 
The remote control allows you to power on/off the DV and to take photos and videos up to 30 

meters away without operating the DV directly. Simply press a button to use your action 

camcorder remotely. 

You can use the remote control to record videos, take photos and power on/off your camcorder, 

without operating the camera.  

• Power On/Off: 
Power On: Press and hold the Power button until the button indicator light turns off. The DV 

will power on.  

Power Off: While the camera is on, press and hold the Power button until the button indicator 

light turns off. The DV will power off. 

• Video Capture: 
Press the Video button after the camcorder has been powered on. If the camera is not in 

Video Capture Mode, the camera will then enter the Video Capture Mode. Once in Video 

Capture Mode, press the Video button to start recording video and press again to stop 

recording your video. 

• Photo Capture: 
Press the Photo button after the camcorder has been powered on. If the camera is not in 

Photo Capture Mode, the camera will then enter the Photo Capture Mode. Once in Photo 

Capture Mode, press the Photo button to take a photo. 

NOTE: Each time a button is pressed, the Button Indicator Lights flash a red light. 

Power button 

Video button: 
Video Capture Mode, 
Video Recording  

Photo button: 
Photo Capture Mode, 
Photo Capture  

Button Indicator Lights (Red) 
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Main Camcorder Modes 
Your camcorder has different modes for the various camera functions. 

Short press the  Power/Mode button to toggle between the modes. 

 

 VIDEO CAPTURE MODE 

 Use this mode to capture videos with your digital camcorder. 

To record a video, please check that the DV is in Video mode. If the  video icon is not 

displayed on the LCD screen, short press the  Power/Mode button repeatedly until it 

appears. To start recording, press the  Shutter/OK button. Press the  Shutter/OK 

button again to stop recording. The video is automatically saved to your camcorder’s 

memory card. 

 

 PHOTO CAPTURE MODE 

 Use this mode to capture pictures with your camcorder. 

To take a photo, please check that the DV is in Photo mode. If the  photo icon is not 

displayed on the LCD screen, short press the  Power/Mode button repeatedly until it 

appears. Press the  Shutter/OK button to capture your photo. The picture is 

automatically saved to your camcorder’s memory card.  

 

 PLAYBACK MODE (PHOTOS & VIDEOS) 

 Use this mode to view and manage the photos and videos on your camcorder. 

Please check that the DV is in Playback mode. Short press the  Power/Mode button 

repeatedly until the Playback mode appears. 

You can scroll through the photos and videos that you’ve previously taken to view or delete 

them as desired. 
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Camcorder Technical Specifications  

 

 

 

 

 

 

 

 

Image Sensor CMOS Sensor  

Video Resolution 1080p@30fps, 720p@60fps, 720p@30fps 

Photo Resolution 12M (4032x3024), 8M (3264x2448), 5MP (2592X1944) 

File Format MOV (Video), JPEG (Photo) 

External Memory Micro SD Memory card, Class 6 or higher, up to 32GB 

LCD Display 2.0” TFT 

Lens Focus Length 2.8M (Fixed lens) 

White Balance Auto, Daylight, Cloudy, Tungsten, Fluorescent 

Light Exposure (Photo) 
+2.0, +5/3, +4/3, +1.0, +2/3, +1/3, +0.0,  

-1/3, -2/3, -1.0, -4/3, - 5/3, - 2.0 

Exposure Auto, 100, 200, 400 

Microphone Yes 

Auto Power Off Off, 1 min., 3 min. 

Languages English, French, German, Italian, Portuguese, Spanish 

Interface Micro USB 

System Requirements 
MICROSOFT® Windows 7 or higher 

MACINTOSH OSX v10.9 or higher   

Battery Built-in 700mAH Lithium Battery 
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Camcorder Mounts and Accessories 

WATERPROOF CASE 

 

1. Clamp 

2. Shutter Release 

3. Power/Mode Button 

4. Tripod Mount 

 

 

 

 

 

 

Your action camcorder comes with a waterproof casing for underwater action and added 

durability. To assemble your camera to the case, follow the instructions below: 

1. To open the case: Insert a finger at the half circle of the latch by prying the latch up - away 

from the case. 

2. Insert the camera lens forward into the case. 

3. Before sealing the waterproof case, make sure the camera housing’s rubber seal clean. 

Close the door and secure the latch. 

4. While the camcorder is in the waterproof casing, press the POWER/MODE button to select 

Video Capture Mode, Photo Capture Mode or Playback Mode. Press the Shutter button 

for recording your videos and capturing your photos.  

 

 

 

 

 

 

1 

2 3 

4 
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NOTE: 

• A single hair or grain of sand can cause a leak. You can test by closing the case without 

inserting the camera. Submerse the case completely in water for about a minute. Remove 

the case from the water, dry off its exterior with a towel, and then open the case. If the 

entire interior is dry, the case is safe for use under water. 

• Before opening the waterproof casing and putting the device in, carefully check whether 

the waterproof ring of the casing is flat and smooth. 

• After placing the device into the waterproof casing and closing the cover, carefully check 

whether the waterproof ring is deformed due to pressure. 

• After every use in salt water you will need to rinse the outside of the housing with non-salt 

water and dry. Not doing this can eventually cause corrosion of the hinge pin and salt 

buildup in the seal, which can cause failure. 

• To clean the seal, rinse in fresh water and shake dry (drying with a cloth may cause lint to 

compromise the seal). Re-install the seal into the grooves of the housing. 
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INSTALLING THE BICYCLE MOUNT: HANDLEBAR CLAMP 

 

 

 

 

 

INSTALLING THE HELMET MOUNTING SYSTEM 
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Powering On Your Camcorder 
 

TURNING POWER ON AND OFF 

1. Press and hold the POWER button for about 3 seconds to turn on the camcorder. 

The LCD screen briefly displays the ‘Vivitar’ screen and opens the default Video Capture 

Mode. A beep can be heard from the camcorder’s buzzer. 

2. Press and hold the POWER button again for about 3 seconds to turn the power off. 

The LCD screen briefly displays ‘Goodbye’ screen and then powers off.  A beep can 

also be heard from the buzzer as the camcorder is being powered off. 

 

 

 

AUTO POWER OFF – POWER SAVING FEATURE:  

Your digital camcorder includes an Auto Power Off power feature that automatically turns off your 

camcorder after a specified time that your camcorder is left idle. The specified time can be set 

using the ‘Auto Power Off’ menu option. Once the camcorder is automatically powered off, you 

can long press the POWER button to power on the camcorder. 
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Changing Camcorder Mode  

THREE MAIN MODES 

1. Video Capture Mode - Use this mode to capture videos with your camcorder. 

2. Photo Capture Mode - Use this mode to capture photos with your camcorder. 

3. Playback Mode (for photos and videos) – Use this mode to view your captured photos 

and videos. 

 

• When the camera is first powered ON, the Video Capture Mode will be active.  

• The icons that appear on the LCD screen are the best default settings so that you can begin to 

capture and enjoy clear quality photos and videos. 

 

SWITCHING MODES 

After turning on the camcorder, you can short press the POWER/MODE button to switch between 

the three modes in turn: 

• In Video Capture Mode, press the SHUTTER button to start recording and press it again 

to stop. 

• In Photo Capture Mode, press the SHUTTER button to take photo. 

• In Playback Mode, press the SHUTTER button to play back your captured Video. 

 
 

 When in Video Capture Mode, this icon will display on the top-left corner of the LCD display. 

 

 When in Photo Capture Mode, this icon will display on the top-left corner of the LCD display 

 

 When in Playback Mode, a ► play icon (for videos) or  a photo icon (for photos) will 

display on the top-left corner of the LCD display. 
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Navigating the Menus 

PHOTO CAPTURE, VIDEO CAPTURE AND PLAYBACK MENUS 

To access the Main Menu for each Mode: 

1. Press the MENU button to open the Main Menus for the current mode. 

2. Press the  DOWN or  UP button to select a specific menu. 

The selected option appears highlighted. 

3. Press the SHUTTER/OK button to confirm and save your selection and open the options for 

the menu you have selected. 

4. To select a specific option, press the  DOWN or  UP button and then the SHUTTER/OK 

button to save the selected option and return to the Main Menu. 

NOTE: 

To go back from the submenus or exit the Main Menu, press the MENU button. 

 

CAMCORDER SETTINGS MENU 

 To access the Camcorder Settings Menu:  

1. Press the MENU button while in the Video Capture or Photo Capture Mode. This opens the 

Main Setup screen. 

2. Press the  DOWN or  UP button to select a specific menu. 

3. Press the SHUTTER/OK button to confirm and save your selection and open the options for 

the menu you have selected. 

4. To select a specific option, press the  DOWN or  UP button and then the SHUTTER/OK 

button to save the selected option and return to the Main Menu. 
 
NOTE:  

• At any time, you can press the MENU button to exit the menus and return to the previous 
screen. 

• Once you change a setting, the setting is saved by your camera until you manually change 
the setting or restore the camera’s default factory settings. 

• After selecting your desired setting, some settings appear as an icon on the LCD screen in 
Capture Mode – indicating the option selected. 
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Video Capture Mode 
The Video Capture Mode allows you to capture videos with your digital camcorder.  

When first powering on your camcorder, Video Capture Mode appears.  

 The Video Capture icon appears on the LCD screen. 

 

TAKING A VIDEO 

1. Selecting the Scene with the LCD Display: 

While in Video Capture Mode use the LCD display to direct the camcorder at the scene 

you would like to capture. 

NOTE: The time available for video capture (as per the installed memory card size and 

selected resolution) is shown on the top left side of the LCD screen. 

2. Changing Resolution: 

If you would like to change the resolution, press the MENU button and then press the   

 DOWN button to select ‘Movie Size’. Next, press the SHUTTER/OK button to view the 

Movie Size options. Press the  UP /  DOWN button to select an option and then 

press the SHUTTER/OK button to confirm the option. 

The Movie Size options include: 

1080FHD -  FHD 1920x1080P@30fps 

720P -   HD720P 1280X720@60fps 

720P -   HD720P 1280X720@30fps  

3. Capturing the Video: 

START: Press the SHUTTER button to start the video capture. 

While the video capture is in progress: 

- The camcorder’s LED busy light turns on (red) and blinks.  

- The elapsed time appears in red on the top left section of the LCD screen. 

- The Video Mode icon is highlighted in red and blinks.  

STOP: To stop the video recording, press the SHUTTER button again.  

4. The video is automatically saved to the camcorder’s Micro SD Memory card. 
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NOTE:  

• When using the Waterproof Case, make sure to set the camcorder settings before placing it 

into the case. 

• While capturing your video, after approximately one minute of video capture, the LCD display 

turns off in order to save power. The busy LED light remains on and the video continues to be 

captured. Press the SHUTTER button to reactivate the LCD display. 

 

 

VIDEO CAPTURE MODE BUTTONS 

Button Description 

SHUTTER/OK 

• START/STOP: Starts and stops the video capture. 

• ENTERS and SAVES SELECTION:  Within the Menu, enters and saves 

the selected Menu Option. 

MENU 
• Opens and exits the menu options for Camera Settings. 

NOTE: Use the UP/DOWN buttons to navigate. 

POWER / MODE 

• LONG PRESS: Powers the camcorder on/off. 

• SHORT PRESS: Standby Mode: Toggles between the Video Capture 

Mode, Photo Capture Mode and Playback Mode.  

 UP • NAVIGATES MENU: Navigates within the Menus. 

 DOWN • NAVIGATES MENU: Navigates within the Menus. 
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VIDEO CAPTURE MODE LCD ICON STATUS DESCRIPTION 

 

The following icons appear on the LCD screen and indicate the selected menu options and 
camera status. 

Item Function Description 

1 Mode Selection 
Displays the current selected Mode: 

 Video Capture Mode  

2 Video Counter /  
Record Indicator 

• Standby Mode: Displays the amount of time 
available for video capture as per selected video 
resolution and memory card size. 

• Record Mode: Displays the elapsed time in red as 
the video is being recorded. 

3 Video Resolution 
Selection 

Displays the selected Resolution Setting. 
The Resolution options include: 
1080PFHD 
720P 60 
720P 30  

4 Cyclic Record 

Displays the selected Cyclic Record Setting. 
The options include: 

Off (NO ICON),  1 minute,  2 minutes,  

 3 minutes,  5 minutes 

5 Battery Indicator 

Displays the status of the battery level. 
 The battery level is full. 
 The battery level is empty. Indication to recharge 

the battery. 
6 Date / Time Displays the date and time. 
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Photo Capture Mode 
The Photo Capture Mode allows you to capture photos with your digital camcorder.  

To enter Photo Capture Mode, power on the camcorder and then short press the POWER/MODE 

button once.  

 The Photo Capture icon appears on the LCD screen. 

 

TAKING A PICTURE 

1. Selecting the Scene with the LCD Display: 

While in Photo Capture Mode use the LCD display to direct the camcorder at the scene 

you would like to capture. 

2. Changing Resolution: 

If you would like to change the resolution, press the MENU button and then press the   

 DOWN button to select ‘Image Size’. Next, press the SHUTTER/OK button to view the 

Resolution options. Press the  UP /  DOWN button to select an option and then press 

the SHUTTER/OK button to confirm the option. 

The Resolution options include: 

12M (4032x3024) 

8M  (3264x2488) 

5M  (2592x1944) 

3. Press the SHUTTER button to capture the photo. 

The number of photos that can be captured with the available memory and selected 

resolution appears on the top, right section of the LCD screen. 

4. The photo is automatically saved to the camcorder’s Micro SD Memory card. 

NOTE:  

When using the Waterproof Case, make sure to set the camcorder settings before placing it into 

the case. 
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PHOTO CAPTURE MODE BUTTONS 

Button Description 

SHUTTER/OK 

• PHOTO CAPTURE: Press to take the picture. 

• ENTERS and SAVES SELECTION:  Within the Menu, enters and 

saves the selected Menu Option. 

MENU 

Opens and exits the menu options for Photo Capture Mode and General 

Camera Settings. 

NOTE: Use the UP/DOWN buttons to navigate. 

POWER / MODE 

• LONG PRESS: Powers the camcorder on/off. 

• SHORT PRESS: Standby Mode: Toggles between the Video Capture 

Mode, Photo Capture Mode and Playback Mode.  

 UP • NAVIGATES MENU: Navigates within the Menus. 

 DOWN • NAVIGATES MENU: Navigates within the Menus. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 24 

PHOTO CAPTURE MODE LCD ICON STATUS DESCRIPTION 

 

The following icons appear on the LCD screen and indicate the selected menu options and 

camera status. 

Item Function Description 

1 Mode Selection 
Displays the current selected Mode: 

 Photo Capture Mode  

2 Photo Resolution 
Selection 

Displays the selected Resolution Setting. 
The Resolution options include: 
12M (4032x3024), 8M (3264x2488),  
5M (2592x1944) 

3 Capture Mode 

Displays the selected Burst Mode or Self Timer 
setting: 
The options include: 

Single (NO ICON),  3 photos,  5 photos, 

 10 photos,  3 seconds Self-timer 

4 Photo Counter 
 

Displays the number of photos available for photo 
capture as per selected photo resolution and memory 
card size. 

5 Battery Indicator 

Displays the status of the battery level. 
 The battery level is full. 
 The battery level is empty. Indication to recharge 

the battery. 
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Playback Mode 
The Playback mode allows you to review and delete photos and videos that you’ve captured with 

your camcorder.  

To enter Playback Mode, power on your camcorder and then short press the POWER/MODE 

button twice. 

When in Playback Mode, a ► play icon (for videos) or  a photo icon (for photos) is shown on 

the top-left corner of the LCD display. 

 

 

VIEWING CAPTURED IMAGES 

While in Playback mode, you can scroll through your captured images to view each image. 

1. Press the  DOWN button to view the next image. 

2. Press the  UP button to view the previous image. 

NOTE: 

• Videos appear with the ► Play icon and file name displayed on the top, left corner of the 

LCD screen. 

• Photos appear with the  Photo icon and file name displayed on the top, left corner of 

the LCD screen. 
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PLAYING CAPTURED VIDEOS ON YOUR CAMCORDER 

1. Scroll through your captured images to select the video you would like to play. 

2. To play your selected video press the SHUTTER/OK button. 

VIDEO CONTROLS: 

- PLAY: To play the selected video, press the SHUTTER/OK button.  

While the video is playing the elapsed time is displayed on the top left in red. 

- PAUSE: While the video is playing, press the SHUTTER/OK button to PAUSE the 

video and press again to continue playing the video. 

- STOP: Press the MENU button to STOP the video playback. 

NOTE: Your camcorder does not include a speaker. In order to hear the sound of the captured 

video you must view the file on your computer. Connect your camcorder via the supplied USB 

cable to your computer and then you can either download or view directly from the camcorder on 

your computer. See the following sections for more information:  

- ‘Getting Photos and Videos from the Camera to the Computer’ 

- ‘Transferring Images Manually from the Camcorder to the Computer’ 
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DELETING CAPTURED IMAGES 

While in the Playback mode, you can delete captured videos and photos saved to the Micro SD 

Memory card in your camcorder using the Playback menu. 

1. Enter the Playback Mode. 

The last captured image (video or photo) appears. 

2. Select the image you would like to delete. 

3. Press the MENU button to enter the Playback Mode Setup menu options. 

NOTE: To exit the menu options, press the MENU button. 

4. Press the  UP or  DOWN button to select and highlight the ‘Delete’ menu option. 

5. Press the SHUTTER/OK button to enter the ‘Delete’ menu options. 

The following options appear:  

- Delete Current: This option deletes the selected image. 

- Delete All: This option deletes all images (videos and photos). 

Press the  UP or  DOWN button to select an option and then press the 

SHUTTER/OK button to confirm. 

6. A window then appears to confirm your selected ‘Delete’ option.  

The following options appear: 

- OK: This option deletes the selected file (if Delete Current was selected) or all files (if 

Delete All was selected). 

- Cancel: This option returns to the previous ‘Delete’ menu screen without deleting the image(s). 

Press the  UP or  DOWN button to select an option and then press the 

SHUTTER/OK button to confirm. 

 

Caution: Please use the ‘Delete’ feature with care. Once images are deleted they are 

permanently deleted from the Micro SD Memory card. Please make sure that you only 

use this feature once you have downloaded and saved all the images you wish to your 

computer. 
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Menu Options 

NAVIGATING THE MENUS 

 To access the Camera Setup Menu:  

1. Press the MENU button while in the Video Capture, Photo Capture or Playback Mode. 

2. Press the  DOWN or  UP button to select a specific menu. 

3. Press the SHUTTER/OK button to confirm and save your selection and open the options for 

the menu you have selected. 

4. To select a specific option, press the  DOWN or  UP button and then the SHUTTER/OK 

button to save the selected option and return to the Main Menu. 

 
 
NOTE:  

• At any time, you can press the MENU button to exit the menus and return to the previous 
screen. 

• Once you change a setting, the setting is saved by your camera until you manually change 
the setting or restore the camera’s default factory settings. 

• After selecting your desired setting, some settings appear as an icon on the LCD screen in 
Capture Mode – indicating the option selected. 
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CAMERA SETTINGS MENU OPTIONS 

To open the Camera Setup options, press the MENU button while in Video Capture or Photo 

Capture Mode. 

The following menu options appear:  

Movie Size, Image Size, Exposure, Cyclic Record, ISO, Date Stamp, Quality, White Balance, 

Capture Mode, Frequency, Screen Saver, Auto Power Off, Language, Beep Sound, 

Date/Time, Format, Default Setting, Version 

 
Menu Name 
and Description 

Menu Options Menu Options Details 

Movie Size 
The ‘Movie Size’ menu allows you to choose 
the desired size of the video taken by your 
camera. Keep in mind that videos with a 
higher resolution will also take up more of 
your camera’s memory. 

1080P (Default) FHD 1920x1080P@30fps 

720P HD720P 1280X720@60fps 

720P HD720P 1280X720@60fps 

  

  

Image Size 
The ‘Image Size’ menu allows you to choose 
the desired size of the images taken by your 
camera. Keep in mind that images with a 
higher resolution will also take up more of 
your camera’s memory.  

12M pixel resolution 4032x3024 

8M pixel resolution 3264x2448 

5M pixel resolution 2592X1944 

  

Exposure (Photos) 
The ‘Exposure’ setting helps you control the 
amount of light that enters your camera’s 
lens. This setting should be adjusted when 
the environment is lighter or darker than 
normal.  When the environment has more 
light than is needed, reduce the exposure 
setting (by using the negative - count) to 
reduce the amount of light allowed into the 
lens by your camera. If the environment has 
less light (darker) than is needed, increase 
the exposure setting (by using the positive + 
count) to increase the amount of light allowed 
into the lens by your camera. 

+2.0, +5/3, +4/3, +1.0, 

+2/3, +1/3, +0.0,  

-1/3, -2/3, -1.0, -4/3, - 

5/3, - 2.0 

Displays selected EV± 
value. 
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Cyclic Record 
The ‘Cyclic Record’ feature is a circulative 
function. Select the setting to a desired time 
and the video will be saved atomically as per 
the setting. 
NOTE: If the memory card is full, the current 
video being recorded will replace previously 
recorded videos. 

(No Icon)  Off  

      1 Minute 

      2 Minutes 

      3 Minutes 

       5 Minutes 

Displays the Cyclic 
Recording setting. 

ISO (Photos) 
The ‘ISO’ menu allows you to set the level of 
sensitivity that your camera has to light in the 
surrounding environment. When the ISO level 
is increased, the image sensor in your 
camera will be more sensitive to light and 
allow you to capture images in lower-light 
situations. The higher sensitivity to light 
however, may reduce the quality of the 
images that are taken. 
When the ISO is reduced, the image sensor 
in your camera will be less sensitive to light 
and will optimize the image quality in 
environments with bright lighting. 

Auto 

100 

200 

400 

Displays the ISO Sensitivity 
setting. 

Date Stamp 
When you capture an image with your 
camera, the image can include a stamp with 
the date and time that the image was taken. 

OFF 

ON 

Off: The date and time 
stamp will not appear on 
captured images. 
On: the date and time stamp 
will appear on captured 
images. 

Quality 
The ‘Quality’ menu allows you to select the 
desired quality level of the images taken by 
your camera. Keep in mind that images with a 
higher image quality level will also take up 
more memory on your camera. 

Fine 

Normal 

Economy 

Displays the image Quality 
setting. 
 

White Balance 
The ‘White Balance’ feature allows your 
camera to adjust the coloring of the captured 
images depending on the type of light source 
in the current environment.  
Properly adjusting the White Balance setting 
to match your current environment will allow 

Auto Automatic white balance. 

Daylight 

 

White balance selected for 

daylight surrounding. 

Cloudy 

 

White balance selected for 

cloudy surrounding.  
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the camera to properly balance the colors in 
the images that are taken with your camera. 

Fluorescent 

 

White balance selected for 

fluorescent surrounding. 

Tungsten White balance selected for 
tungsten lighting. 

Capture Mode 
‘Capture Mode’ allows you to select the 
method of capturing your photos: either single 
photo capture (standard shooting), burst or 
self-timer.  
When enabled, the ‘Burst Mode’ feature 
allows you to take rapid snapshots in a row 
with a single click of the Shutter button.  
This feature can be effective when trying to 
capture a particular moment in a sporting 
event or other scenes with quick movements. 
The Self Timer feature allows you to set a 
delay between the time that the camera’s 
Shutter button is pressed and the actual 
capture of the picture. This is an optimal 
feature if you don’t just want to take the 
picture but would also like to be in the picture 
yourself. Just set the Self Timer, press the 
Shutter button on your camera and position 
yourself in front of the camera as desired.  

(No icon) Single 

 3 Shooting 

 5 Shooting 

 10 Shooting 

 3S Timer 

Single: Normal image 

capture - one photo at a time 

(Default). No icon appears 

on the screen. 

The photo is taken as soon 

as you press the Shutter 

button. 

3 Shooting: Captures three 

continuous photos. 

5 Shooting: Captures five 

continuous photos. 

10 Shooting: Captures ten 

continuous photos. 

3S Timer: Sets a 3-second 

delay from when you press 

the Shutter button until the 

photo is taken. 

Frequency 
The options in the ‘Frequency’ menu 
represent the frequency of the electrical 
current in fluorescent lighting sources in your 
locale. If your camcorder is set to a frequency 
that does not match your country’s electric 
current, you may see waves on the images 
taken by your camcorder. 

50Hz 

60Hz 

Selects power frequency in 

your location: 

50Hz: UK, Europe and 

Australia 
60Hz: US, Canada and 
South America 

Screen Saver 
The ‘Screen Saver’ feature allows the camera 
to save power by turning off the LCD screen 
while the video is being captured. The 
camera continues to capture the video while 

Off 

1 Minute 

3 Minutes 

5 Minutes 

Off: The camera LCD 
screen remains on during 
video capture. 
1 Minute: The LCD screen 
goes into screen saver mode 
(the screen appears black) 
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the LCD appears black and the red LED busy 
light blinks. Short pressing the Shutter button 
reactivates the LCD screen to show the video 
being captured. 

after 1 minute of video 
capture. 
3 Minutes: The LCD screen 
goes into screen saver mode 
(the screen appears black) 
after 3 minutes of video 
capture. 
5 Minutes: The LCD screen 
goes into screen saver mode 
(the screen appears black) 
after 5 minutes of video 
capture. 
Note: During video recording 
when the screen is in Screen 
Saver mode, short press the 
Shutter button to reactivate 
the LCD screen. 

Auto Power Off 
You can use the ‘Auto Power Off’ feature to 
conserve your camcorder’s battery life. The 
designated time represents when your 
camcorder will automatically power off.  
When the camcorder sits idle for the 
designated period of time, the camcorder will 
shut off completely and will need to be 
powered on again with the power button 
before the next use. 

Off 

1 Minute 

3 Minutes 

OFF: The camcorder 

remains on.  

 

1 Minute: The camcorder 

powers off after 1 minute of 

sitting idle. 

 

3 Minutes: The camcorder 

powers off after 3 minutes of 

sitting idle. 

Language 
You can select your camera’s language 
setting by selecting the desired language 
from the ‘Language’ menu. 

English 

French 

German 

Italian 

Portuguese 

Spanish  

Selects the camcorder’s 
language as seen in the 
Camera modes and settings. 

Beep Sound 
The ‘Beep Sound’ menu allows you to control 
the beep sound that is emitted when pressing 
any button on the camera. 

Off 

On 

Controls the beep sound 
heard when pressing a 
button on the camera. 
Off: No sound can be heard 
when pressing the camera 
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buttons. 
On: A beep can be heard 
each time a button on the 
camera is pressed. 

Date/Time 
The ‘Date & Time’ menu allows you to set 
your camcorder’s date and time. This date 
and time will appear on the captured images 
when the Date Stamp is set to be active and, 
on the screen, while in Video Capture Mode. 

YEAR/MONTH/DAY 

HR: MIN: SECOND 

YY/MM/DD 

To set the MM/DD/YY and 
Hour: Minutes: Seconds: 
- Press the UP/DOWN 

button to change the 
setting and specify each 
part of the date and time. 

- Short press the 
Shutter/OK button to 
toggle and move between 
the time and date settings. 

- Press the MENU button to 
save and confirm the date 
and time setting and exit 
the setting screen. 

Format 
You can use the ‘Format’ menu to delete all 
the content that is currently on your camera’s 
memory card.  
This option will automatically delete all the 
content at one time. If you would like to delete 
individual images, use the Delete menu in the 
camera’s Playback Mode. 
Keep in mind that formatting the memory card 
will permanently delete all the content on your 
camera’s memory card. Please make sure 
you have backed up the images that you want 
before you proceed with the format of the 
memory card. 

Cancel 

OK 

Formats the Micro SD 
Memory Card. 
Cancel: Does not delete the 
images on your memory 
card.  
Exits the ‘Format’ submenu 
screen without deleting all 
images. 
OK: Automatically deletes all 
images on the memory card.  
The memory card will be 
completely formatted. 

Default Setting 
Use the ‘Default Setting’’ menu to reset your 
camcorder settings to the Factory Default 
Settings. 

Cancel 

OK 

Resets the camera to the 
Factory Default Settings. 
Cancel: Does not reset the 
camera to the Factory 
Default Settings. Exits the 
submenu without resting and 
keeps the current settings. 
OK: Automatically resets the 
camera to the Factory 
Default Settings. 

Version 2017103 v1.2 Displays the camera’s 
version number. 
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PLAYBACK MODE MENUS 

To open the Playback menu options, press the MENU button while in Playback Mode. 

The following menus appear when a video or photo is selected: 

Delete, Format 
 
Menu Name 
and Description Menu Options Menu Option Details 

Delete 
While in the Playback Mode, you can delete 
pictures from your camera through the 
‘Delete’ menu. You can delete a single 
photograph / video clip, or delete all images 
saved to the SD card. 
 
IMPORTANT: Keep in mind that deleting 
will permanently remove the selected 
images on your camera’s memory card. 

Delete Current 

Delete All 

Delete Current: Deletes 
the one selected file 
(photo/video). 
 
Delete All: Deletes all the 
photos and videos.  
 
NOTE: 
It is highly recommended to 
first save and download 
your images before 
deleting. 

Format 
You can use the ‘Format’ menu to delete all 
the content that is currently on your camera’s 
memory card.  
This option will automatically delete all the 
content at one time. If you would like to delete 
individual images, use the Delete menu in the 
camera’s Playback Mode. 
Keep in mind that formatting the memory card 
will permanently delete all the content on your 
camera’s memory card. Please make sure 
you have backed up the images that you want 
before you proceed with the format of the 
memory card. 

Cancel 

OK 

Formats the Micro SD 
Memory Card. 
Cancel: Does not delete 
the images on your 
memory card.  
Exits the ‘Format’ submenu 
screen without deleting all 
images. 
OK: Automatically deletes 
all images on the memory 
card.  
The memory card will be 
completely formatted. 
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Computer System Requirements 
To be able to download videos and photos to your computer using the ‘Vivitar Experience Image 

Manager’ Software, you will need the following minimum configuration: 

WINDOWS OS 

• MICROSOFT® Windows 7 or later 

• Pentium® 4 processor (or above)  

• 1 GB RAM, 250 MB available hard disk space  

• 16-bit Color monitor, 1024 X 768 recommended screen resolution  

• QuickTime® 6 or higher  

• MICROSOFT ® Internet Explorer 7 or higher 

• Windows Media Player 10 or higher  

• DirectX 9 or higher 

• Internet connection required 

 

MACINTOSH OS 

• Intel processor running MACINTOSH OS X v10.9 or later  

• 1 GB RAM, 250 MB available hard disk space  

• Display: 1024 x 768 or higher-resolution monitor  

• QuickTime® 6 or higher  

• Internet connection required 

 

NOTE:  

• Internet connection required. 

• Make sure the latest compatible Adobe® Flash® Player is installed on your computer. 
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Installing the Software 
You must be connected to the Internet to download the Vivitar Experience™ Image 

Manager software. 

The Vivitar Experience Image Manager Software can be downloaded and installed via the 

following online links: 

WINDOWS OS: http://tinyurl.com/viviwin  

MAC OS: http://tinyurl.com/vivimac  

 

1. Enter the appropriate URL (shown above) into a web browser on your computer.  

2. The file for installing the software automatically begins to download to your computer. 

Please note that the web page appears empty, however the download automatically 

begins.  

3. Locate the downloaded application files on your computer’s ‘Downloads’ folder once the 

download is complete: 

On WINDOWS OS the file name is: vivitargeneric_win.exe 

ON MAC OS in file name is: vivitargeneric_mac.pkg 

4. Double click on the downloaded application file to install the Vivitar Experience Image 

Manager Software. 

5. Follow all instructions. 

6. Once installation is complete, the Vivitar Experience Image Manager opens automatically. 

 

Connecting the Camcorder to the Computer 
1. Use the supplied USB cable to connect your digital camcorder to your computer. 

2. Power the camcorder ON. 

3. The first time you connect the device to the computer you may have to wait a few 

seconds until the computer recognizes the device. 
 

http://tinyurl.com/viviwin
http://tinyurl.com/vivimac
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Getting Photos and Videos from the Camcorder to the 
Computer 
The Micro SD Memory card needs to be inserted. Do not disconnect the cable during transfer. 

Doing so will cancel the transfer of any files on their way to your computer. 
1. Select the “Get Images” button from the Main menu. 

 

2. The “Get media from device” window opens. 

3. You can select to download videos. 

4. Select your camera (removable disk) from the device window. If your camera is the only 

USB device connected, then it will be selected automatically. 

5. Select a location on the computer where to place the new video files. 

6. Add the new video files to albums if desired. 

7. Select to remove the media files from the selected device (removable disk) after the import. 

8. Click the “Get Media” button to transfer the videos from your camera to your computer. 

9. A media download progress bar appears on the bottom left showing the number of media 

files downloading to your computer. A message appears when the download is complete. 

10. The video files that you selected are now downloaded to your computer to the selected 

folder ready for your use.       
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Getting Started! 
Using the Vivitar Experience Image Manager you can: 

• Upload and manage videos to and from the most popular photo sharing and social networking 

sites - Facebook, Flickr, Picasa, Photobucket, Twitter and YouTube  

• Seamlessly transfer videos from one social network to another 

• Organize your images by creating offline and online albums  

• Edit images using automatic and manual tools  

• Use automatic “Geotagging” with built in Google Maps 

For more details on how to use the Vivitar Experience Image Manager open the Help file or 

click the “Take a Tour” button on the application’s Home screen. 

 

 

Transferring Images Manually from the Camcorder to 
the Computer 

WINDOWS OS 

1. Use the supplied USB cable to connect your camcorder to your computer’s USB port. 

2. Power on the camcorder. ‘MSDC’ displays on the LCD screen.  

3. A window appears on your computer with a list of options, select “Open folder to view 

files” and click ‘OK’. 

4. Open the DCIM folder and the folder inside to view the media files. 

5. Select the media and copy the files from this folder into your computer. Optionally, select 

the files and choose ‘Copy’ from the Edit menu. Then select a folder and choose ‘Paste’ 

from the Edit menu.  

6. We recommend that you copy the photos into the Pictures/My Pictures folder and the 

videos into the Videos/My Videos folder. 

7. Do not disconnect the cable during transfer. Doing so will cancel the transfer of any files 

on their way to your computer. 
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MACINTOSH OS 

1. Use the supplied USB cable to connect your camcorder to your computer’s USB port. 

2. Power on the camcorder. ‘MSDC’ displays on the LCD screen.  

3. The camcorder’s device icon appears on the desktop. 

4. Click on the device icon and open the DCIM folder and the folder inside to view the media 

files. 

5. Select the files and drag them into your computer. Optionally, select the files and choose 

‘Copy’ from the Finder’s Edit menu. Then select a folder and choose ‘Paste’ from the Edit 

menu. 

6. We recommend that you copy the photos into the Pictures folder and the videos into the 

Movies folder. 

7. Do not disconnect the cable during transfer. Doing so will cancel the transfer of any files 

on their way to your computer. 

 

TRANSFERRING PHOTOS AND VIDEOS:  APPLE IPAD 

NOTE: Please check your device packaging for compatibility with the iPad. 

APPLE IPAD CAMERA CONNECTION: 
For models that are compatible with the iPad, photos and videos can be imported from your 

digital camcorder to your iPad by following either one of the options below: 

1. Connecting your digital camcorder to your iPad using an iPad Camera Connector: 

 Plug the Camera Connector into the dock connector port on your iPad, then attach your 

digital camcorder using a USB cable (included) to the Camera Connector. 

 NOTE: iPad Camera Connector not included. This may be purchased separately. 

2. Using an iPad SD Card Reader: 

Connect the SD Card Reader to your iPad, then insert your digital camcorder's Micro SD 

Memory card into the slot to import photos and videos directly from your camera's SD card. 

NOTE: iPad SD Card Reader not included. This may be purchased separately. 

After you make the connection, your iPad automatically opens the Photos application. This 

allows you choose which photos and videos to import, then organizes them into albums. 
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Camcorder Maintenance 
Please read the information below carefully before using your camcorder for proper and safe 

operation, to use the camcorder to its fullest and maintain its performance. 

 

MEMORY CARD MAINTENANCE: 

• For the first time of using a new memory card, or when there is unrecognized data for the 

camera or images with other cameras in the memory card, please make sure to firstly format 

the memory card. 

Note: Please back up the data if the memory card inside has been previously used. After that, 

format the memory card of this video camera. 

• Please power the camera off before inserting in or taking out the memory card. 

• Keep the memory card clean and prevent it from contacting liquid. In case of liquid contacted, 

clean and dry it with a piece of soft cloth. 

• In case of idle use, please keep the memory card in a guard staple. 

• Please note that the memory card will get hot after long-term use. This is normal. 

• It is recommended to backup the important data from your memory card to other media such 

as soft disk, hard disk or CD. 

• To ensure image quality, minimum Class 6 High-Speed card is needed.  

• The following situations may cause loss or damage of the data on your memory card:    

1. Improper use of the memory card. 

2. The memory card has been bent, dropped or collided. 

3. The memory card has been placed under high temperature or moist environment or 

expose to sunshine directly. 

4. Electrostatic or electromagnetic field exists around the memory card. 

5. The memory card has been taken out or the power supply interrupted while the camera or 

computer is connected to the memory card (i.e. during reading, writing and formatting).  

6. Taking out the memory card while powering off, while recording, deleting (formatting) or 

reading. 

7. The service life of the memory card has expired (please replace the memory card regularly). 
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DEVICE MAINTENANCE: 

• Take good care of the video camera and prevent water or sand particles from entering the 

video camera when it is used on the beach or near water. Please note that water, sand 

particles, dust or component containing salt may damage the video camera. 

• Keep the video camera free of dust and chemical materials. Place it in a cool, dry and well 

ventilated place. Do not place the video camera in a high temperature, moist or dusty place. 

• If dirt or stains accumulate on the video camera or on its lens, use a soft, clean and dry rag to 

wipe it away gently. If the video camera or its lens is stained with sand particles, blow them 

away gently. Do not use cloth to wipe arbitrarily. Otherwise, it may scratch the surface of video 

camera or its lens. 

• Do not touch the lens surface with fingers.  

• If it is required to clean the camera surface, first blow away the sand dust accumulated on the 

surface, and then wipe the camera gently with a rag or tissue appropriate for optical 

equipment. Please use a cleaning agent specifically for a video camera when wiping if 

necessary. Do not use organic solvent to clean the video camera. 

• The digital camcorder is a delicate device: 

1. Please handle your camcorder with care to avoid damaging it. 

2. Do not expose your camcorder to heat sources. 

3. Do not use your camcorder in wet or moist conditions without the waterproof casing. 

4. Use proper protective cover to avoid lens and display from being scratched. 
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Sakar Warranty Card 
This warranty covers for the original consumer purchaser only and is not transferable. Products 

that fail to function properly UNDER NORMAL USAGE, due to defects in material or 

workmanship will be repaired at no charge for parts or labor for a period of one year from the time 

of purchase. 

 

What Is Not Covered By Warranty: 

Damages or malfunctions not resulting from defects in material or workmanship and damages or 

malfunctions from other than normal use, including but limited to, repair by unauthorized parties, 

tampering, modification or accident. 
 
What to Do When Service Is Required: 

When returning your defective product (postage pre-paid) for service, your package should 

include: 

1. Copy of original bill of sale. 

2. A detailed written description of the problem. 

3. Your return address and telephone number (Daytime). 
 
MAIL TO ADDRESS BELOW: 

 

 

 

 

 

 

 

 

 

Sakar US 
Sakar International 
Attention: Service Department 
195 Carter Drive 
Edison, NJ      
08817 

Sakar Australia 
Return faulty camera to the Refund 
Counter at the store where purchased 
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Technical Support 
For technical support issues please visit our website at www.vivitar.com. You can find manuals, 

software and FAQ’s at the website. Can’t find what you are looking for? E-mail us at 

support@vivitar.com and one of our technical support team members will answer your 

questions. For phone support in the US please call 1-800-592-9541 and in Australia call 

1800-006-614.  If you would like to call from anywhere else, please visit www.vivitar.com for 

your local toll-free number.  
 

 

Troubleshooting 
Q: I have taken photos and selected the “Get Images” button. I get a message that the 

images were successfully transferred but the photos do not appear on my computer.  

What do I do? 

First ensure that you have in fact taken photos. Press the Shutter button to take some sample 

photos or videos and then try downloading them again. 

If the photos are saved to the SD memory card, then all the photos should appear. 

  

Q: How do I make sure I don't lose important pictures? 

This camcorder requires a Micro SD card for normal use. If the camera powers off nothing will 

happen to the images stored on the memory card. We recommend always downloading your 

photos and videos to your computer as soon as possible to prevent unintentional data loss.     

 

Q: I deleted images using the Vivitar Experience Image Manager. The images were also 

deleted from my computer. How do I recover images that I accidently deleted? 

All images deleted using the Vivitar Experience Image Manager are sent to your computer’s 

Recycle or Trash Bin and can be retrieved from there.           
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